InDesign, Part 2

Create a new document

Start *InDesign*, choose **File**, then **New**. On the sub-menu, choose **Document**. The **New Document** dialog appears on which you will specify the settings for the new document. Set the number of pages at 2 without facing pages. Leave the page size and margins dimensions at the default settings. Specify two columns with a gutter of 1p6. See an illustration of the document settings at right.

Create a new master

Master pages are the background on which you lay out your document pages. When you assign a master page (or spread) to a document page, *InDesign* applies the margin and column settings of the master spread to the page. Pull down the **Window** menu and choose **Pages**. The **Pages** palette displays, and it is illustrated at right.

This two-page document will be a flyer with a front and a back. You may want a different layout on the back from the front.

Choose **New Master** from the **Pages** palette menu. (See the small triangle with the circle in the upper left of the Pages palette.) The menu depicted at the right is the upper portion of the **Pages** palette menu. Choose the **New Master** command.

1. The **New Master** dialog displays. See it above.
2. Since the B-Master is based on A-Master, it contains the margin settings of the A-Master. If you ever had to change the basic margin settings of the document, changing these settings on the A-Master would automatically change them on the B-Master page.
3. In the picture of the **Pages** palette, in the top section, you see the master pages None, A-Master, and B-Master.
4. To apply the B-Master page to page 2 of the document, drag the B-Master page icon and drop it on the top of Page 2 icon.
5. See on the picture of the Pages palette. In the bottom section, Page 2 has the B-Master applied to it.
6. Look at the picture of the **Status Bar** menu that shows the two document pages at the top and the two Master pages on the bottom.
The InDesign Work Area

In the introductory lesson, you learned a little about some of the basic features of the InDesign CS2 program. In this second lesson, you have created and attached a master page. You will now review the work area and create some paragraph styles. When you first start InDesign, the CONTROL palette and the TOOLBOX are displayed, along with several groups of palettes, some of which are collapsed at the side of the application window (WIN) or screen (MAC).

The Toolbox

At the right, you see a screen picture of the TOOLBOX.

At the right and left of each tool, you see the name of each tool and its shortcut key. The TYPE tool and SELECTION tool are the most frequently used.

Control palette

The CONTROL palette is context-sensitive: it displays different options depending on the type of object you select.

Below, see a screen picture of a portion of the CONTROL palette in CHARACTER FORMATS view. Note that character formats are identified. Paragraph formats are not shown.

InDesign’s palettes

When you start InDesign, several groups of palettes are collapsed into tabs at the side of the application window (Windows) or screen (Mac OS).

You can move collapsed palettes into windows of their own or collapse other palettes into side tabs. Palettes collapsed into side tabs can be grouped and rearranged, but they cannot be docked while they are collapsed.

Note: You cannot collapse the TOOLBOX, CONTROL palette, TABS palette, or PageMaker toolbar into side tabs. InDesign palettes are listed in the WINDOW menu. A check mark next to the palette’s name indicates that the palette is showing at the front of its group and is not hidden beneath another palette group. You can display or hide palettes using the WINDOW menu. Most palettes have a menu in the upper right or left corner (a small triangle).
Opening and Collapsing Palettes

Illustrated at the far right is a collapsed group of palettes against the right application window in a Windows computer. At its left, is the same group of palettes opened. To open a collapsed palette, click on its tab at the left. To collapse a group of palettes, click on any blank space on its left border.

To convert a collapsed palette to a floating palette, drag a palette’s tab away from the side of the application window (Windows) or screen (Mac OS).

To collapse a palette into a side tab, select the palette’s tab and drag it to the left or right side of the application window (Windows) or of the screen (Mac OS).

Using context menus

Unlike the menus that appear at the top of your screen, context-sensitive menus display commands related to the active tool or selection. You can use context menus as a quick way to choose commonly used commands by positioning the pointer over the document or an object in the document and clicking the right mouse button.

Note (Mac OS): If you do not have a two-button mouse, you can display a context menu by pressing the Control key as you click with the mouse.

InDesign Pages

Page Size

When setting up your document, either choose a page size from the menu or type values for width and height. Page size represents the final size you want after bleeds or other marks outside the page are trimmed.

Orientation

Select Portrait (tall) or Landscape (wide). These icons interact dynamically with the dimensions you specify for page size. When page height is the larger value, the portrait icon is selected. When page width is the larger value, the landscape icon is selected.

Bleed and Slug Areas

Bleed

To specify the dimensions of the bleed and slug areas, click More Options in the New Document dialog box. To make the bleed or slug areas extend evenly on all sides, click the Make All Settings the Same icon. The bleed area is used to align objects that you want to extend all the way to the trimline of your printed document. The bleed area allows you to print objects that are arranged at the outer edge of the defined page size. For a page of the required dimensions, if an object is positioned at its edge, some white may appear at the edge of the printed area due to slight misalignment during printing. For this reason, you should position an object that is at the edge of the page of the required dimensions a little away from the edge, and trim after printing. Bleed area is shown by a red line on the document. You can set bleed area settings from Bleed in the Print dialog box.

Slug

The slug area is used for instructions to the printer, sign-off forms, or other information related to your document. The slug area is discarded when the document is trimmed to its final page size. The slug area holds printing information, customized color bar information, or displays other instructions and descriptions for other information in the document. Objects (including text frames) positioned in the slug area are printed but will disappear when the document is trimmed to its final page size.
Place the text file provided

First, drag a guide down to 6 on the vertical ruler. Above the guide, take the text tool and draw from the upper left of the page margins down to the right of the opposite page margin and the top of the guide. You will be given a text file that you will place at the upper left of the left column just beneath the guide. Flow this text (holding down the Shift key) which will automatically flow the text to fill the first column and then will flow to the second column. Cut the first paragraph, which will be the main heading. Place it in the text frame you created that spans the page above the guide. Delete any space created when you deleted the heading at the top of the left column of text.

Using Styles

A character style is a collection of character formatting attributes that can be applied to text in a single step. A paragraph style includes both character and paragraph formatting attributes, and can be applied to a paragraph in which your cursor rests or to a range of paragraphs you have selected. When you change the formatting of a style, all text to which the style has been applied will be updated with the new format.

By default, each new document contains a [Basic Paragraph] style that is applied to text you type. You can edit this style, but you can’t rename or delete it. You can rename and delete styles that you create. You can also select a different default style to apply to text.

Create two paragraph styles

In this lesson you will create a style by first formatting a paragraph, then selecting the paragraph, and then creating a style with most of the style formats already defined.

Create a Main Heading style

Select the text at the page top and use the Control Palette to format the heading as follows:

Choose the Arial typeface, then choose Bold.

Click on the paragraph symbol in the Control Palette. You will be able to input paragraph formats here.

Click the second icon on the left on the second row. This will center the text.

Click in the last box in the upper row and click the up arrow until you have the setting at 0p6. This will add a Space After to the paragraph on which this style is attached.

To create the paragraph style, display the Paragraph Styles palette. Either choose Paragraph Styles in the Type menu or click the Paragraph Styles tab, which appears by default on the right side of the application window.

Choose New Paragraph Style from the Paragraph Styles palette menu. For Style Name for your new style, type Main Heading.

For Based On, leave the default basic paragraph style as the default.

For Next Style, leave the default setting You will change this to Body Text when you create a Body Text style.

Create a Body Text style

With your cursor placed any place in the column, select all the text (Ctrl/Cmd+A).

In the Control Palette, specify the following for the typeface: Choose Times New Roman; for Font Style, choose regular; for Size, choose 12 pt, for Leading, leave it at the default.

Click the Paragraph icon on the Control Palette, and Click the first icon on the left on the second row. This will justify the text with the last line aligned left.
Click in the last box in the upper row and click the up arrow until you have the setting at 0p6. This will add a Space After to the paragraph on which this style is attached.

**Open the Paragraph Styles Palette.**

Click on the Paragraph Styles Palette menu and select New Paragraph Style. Notice that the formatting you have already done is shown in this New Paragraph Styles dialog.

You may want to click Indents and Spacing on the left. In that dialog, check to see that this style specifies the Alignment as Justified. Leave all indents at 0. Do not specify any space before the paragraph but do check that the space after the paragraph as 0p6. This will provide an extra space of 6 points after each paragraph with the Body Text style applied to it. This separates the text paragraphs.

When you've finished specifying the formatting attributes, click OK.

Note: You can automatically apply styles as you type text. If, for example, your document’s design calls for the style “Body Text” to follow a heading style named “Subhead 1,” you can set the Next Style option for “Subhead 1” to “Body Text.” After you've typed a paragraph styled with “Subhead 1,” pressing Enter or Return starts a new paragraph styled with “Body Text.” This saves time, so that you do not have to stop and apply the style to the text following the heading.

**Modify the Main Heading Style**

With the Paragraph Styles palette menu open, double click on the Main Heading style.

In the Paragraph Style Options dialog, set the Next Style to Body Text.

Click OK. Your Main Heading style has been modified.

When you select text or position the insertion point, any style that has been applied to that text is highlighted in the Styles palette. If you select a range of text that contains multiple styles, no style is highlighted in the Styles palette.

**Place the graphic**

You have been given a graphic to place in the center of the page so that it spans the left and right columns. Using the Selection tool, use the Place command on the File menu. (Be sure that the Replace Selected Item is deselected in the Place dialog.)

Place the graphic vertically according to where you think it should go. Notice the top and bottom “handles” that are in the center of the top and bottom border of the graphic. They will help you center the graphic horizontally. With the graphic selected, use the Text Wrap palette to set the text offset. Since the text is justified on the left and the right, it makes an appealing page.

If you want to use this page design in your work to announce a project, book, lesson, or course, you may wish to use the second page for more information.
Below is a picture of the of the InDesign document you have created.